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File Listing

	Task
	Exercise
	Recommended Method
	Student Data File
	Solution File

	Choose a Slide Layout for a Chart
	12-1
	Insert a slide that uses the Title and Content slide layout. Click the Insert Chart icon in the center of the content placeholder.
	Finance1.ppt
	None

	Make Changes to Sample Datasheet
	12-2
	Ensure that the mouse pointer is a cell pointer. Use the buttons on the Standard toolbar to make changes.
	None
	None

	Delete Sample Data
	12-3
	Click the cell the contents of which are to be deleted. Press [Delete].
	None
	None

	Key New Chart Data
	12-4
	Key the numbers and labels as shown in the reference file in the unnumbered row above row1 and an unlettered column to the left of column A.
	None
	None

	Switch Rows and Columns
	12-5
	Click the By Column button on the Standard toolbar to group according to column. Click the By Row button on the Standard toolbar to group according to row.
	None
	Sol-12-5.ppt

	Hide the Datasheet and View the Chart
	12-6
	Click the View Datasheet button on the Standard toolbar to hide the datasheet.
	None
	None

	Explore Parts of a Chart
	12-7
	Using the tip of the pointer, point to an object on the chart. The ScreenTip identifies the object by its name.
	None
	None

	Work with Solid Color Fills
	12-8
	Select the desired columns. Use the Fill Color button on the Standard toolbar.
	None
	None

	Work with Pattern and Gradient Fills
	12-9
	Double-click a column to open the Format Data Series dialog box. Click Fill Effects on the Patterns tab to open the Fill Effects dialog box. Click the Pattern tab. Change the fill pattern.

Click the Gradient tab on the Format Data Series dialog box. Select one of the displayed gradients.
	None
	Sol-12-9.ppt

	Format the Value Axis
	12-10
	Double-click the value axis to open the Format Axis dialog box. Use the options on the Format Axis dialog box to format the value axis.
	None
	None

	Format the Category Axis
	12-11
	Right-click the text on the category axis and choose Format Axis from the shortcut menu. In the Format Axis dialog box, click the Font tab and choose appropriate options.
	None
	None

	Insert Axis Titles
	12-12
	Move the mouse pointer near the right edge of the chart until users see the Chart Area ScreenTip. Right-click the chart area and choose Chart Options from the shortcut menu. Click the Titles tab in the Chart Options dialog box. Key the title in the Category (X) axis and the Value (Z) axis text box.
	None
	None

	Change or Remove the Legend
	12-13
	Right-click the legend box and choose Format Legend. Select appropriate options in the Format Legend dialog box.
	None
	Sol-12-13.ppt

	Switch to Other Chart Types
	12-14
	Choose Chart, Chart Type.

Alternatively, right-click the chart area, and choose Chart Type from the submenu.
Or, click the list box arrow for the Chart Type button, float the Chart Type menu, and then make a selection from the Chart Type toolbar.
	None
	None

	Add a Secondary Chart Axis
	12-15
	Activate the chart. Right-click one of the columns and choose Format Data Series from the shortcut menu. Click the Axis tab. Select Secondary axis in the Plot series on option box.
	None
	None

	Combine Chart Types
	12-16
	Select the data series. Choose the chart types from the buttons on the Chart Type toolbar.
	None
	None

	Format a Primary and Secondary Axes
	12-17
	From the Chart menu, choose Chart Options and click the Titles tab. In the Value (Y) axis text box and the Second value (Y) axis text box, key the axis titles. Right-click Value Axis and choose Format Axis. Right-click Secondary Value Axis and choose Format Axis. Click the Scale tab.
	None
	Sol-12-17.ppt

	Create a Pie Chart
	12-18
	Click the Insert Chart button on the Standard toolbar. Click the list box arrow for the Chart Type button on the Standard toolbar. Choose Pie Chart.
	None
	None

	Add Pie Slice Labels
	12-19
	Right-click one of the slices of the pie chart and choose Format Data Series. Click the Data Labels tab. In the Label Contains section, select both Category name and Percentage.
	None
	None

	Format the Pie Plot Area
	12-20
	Right-click the pie plot area and choose Format Plot Area from the shortcut menu.
	None
	None

	Enhance a Pie Chart
	12-21
	The color of a pie slice can be changed using the Fill Color button on the Standard toolbar. Place the pointer in the middle of the pie slice and drag it slightly away from the center of the pie to explode the slice.
	None
	Sol-12-21.ppt

	Embed an Excel Chart
	12-22
	Choose Insert, Object. In the Insert Object dialog box, select Create from file. Click Browse and navigate to the location of the Excel sheet. Choose the Excel sheet and click OK.
	Apparel1.xls
	Sol-12-22.ppt

	Insert a Linked Excel Chart
	12-23
	Choose Insert, Object. In the Insert Object dialog box, select Create from file. Click Browse and navigate to the location of the Excel sheet. Choose the Excel sheet and click OK. Click the Link check box under the File box. Click OK.
	Apparel3.xls
	Sol-12-23b.ppt

	Adding AutoShapes for Emphasis
	12-24
	Use the AutoShapes menu on the Drawing toolbar.
	None
	Sol-12-24.ppt

	Animating Chart Elements
	12-25
	Right-click the graph, select Custom Animation. In the Custom Animation task pane, click Add Effect and choose an effect.
	None
	Sol-12-25.ppt

	Create a new presentation that includes a simple column chart.
	12-26
	
	FinSum1.ppt
	Sol-12-26.ppt

	Edit and format an existing chart.
	12-27
	
	Finance2.ppt
	Sol-12-27.ppt

	Add data to a chart, format chart axes, and add a secondary axis.
	12-28
	
	Finance3.ppt
	Sol-12-28.ppt

	Create and format a pie chart; import an Excel chart; and add shapes, text boxes, and animation effects. 
	12-29
	
	Apparel2.ppt
	Sol-12-29ppt

	Create a presentation containing a column chart and format the chart.
	12-30
	
	Logo1.cgm
	Sol-12-30.ppt

	Insert a chart; change the chart to a combination chart; format the chart text, data series, and legend; add a secondary axis; and add an AutoShape.
	12-31
	
	Earnings2.ppt
	Sol-12-31.ppt

	Customize a presentation design template, and create and format an animated pie chart with hyperlinks.
	12-32
	
	Expense2.ppt
	Sol-12-32.ppt

	
	12-33
	
	None
	None

	
	12-34
	
	None
	None

	
	12-35
	
	None
	None


The outline for this lesson will be presented in the following two sections:



Lecture Outline

· Highlights from the text

· Short discussions on difficult items

Lecture Notes

· Notes

· Teaching tips

· Text figures

· PowerPoint slides

Lesson Outline

Section 12.1

Creating a Chart
This section focuses on:

· Choosing a Slide Layout for a Chart

· Making Changes to Sample Datasheet

· Deleting Sample Data

· Keying New Chart Data

· Switching Rows and Columns

· Hiding the Datasheet and Viewing the Chart

Section 12.2

Formatting a Column Chart

This section focuses on:

· Exploring Parts of a Chart

· Working with Solid Color Fills

· Working with Pattern and Gradient Fills

· Formatting the Value Axis

· Formatting the Category Axis

· Inserting Axis Titles

· Changing or Removing the Legend

Section 12.3

Using Different Chart Types

This section focuses on:

· Switching to Other Chart Types

· Adding a Secondary Chart Axis

· Combining Chart Types

· Formatting a Primary and Secondary Axes
Section 12.4

Working with Pie Charts

This section focuses on:

· Creating a Pie Chart

· Adding Pie Slice Labels

· Formatting the Pie Plot Area

· Enhancing a Pie Chart

Section 12.5

Importing Charts from Excel

This section focuses on:

· Embedding an Excel Chart

· Inserting a Linked Excel Chart
Section 12.6
Enhancing Chart Elements

This section focuses on:

· Adding AutoShapes for Emphasis

· Animating Chart Elements

	Lecture Outline
	Lecture Notes

	Creating a Chart

Charts:

· Are diagrams that display numbers in a pictorial format.

· Are sometimes also called graphs.

· Help users to understand the significance of numeric information more easily than viewing the same information as a table or a list of numbers.
Section 12.1

Creating a Chart

PowerPoint enables users to add a chart to an existing slide. Alternatively, users can create a new slide by selecting a slide layout with a chart placeholder.
Users can create a chart in PowerPoint using any of the following methods:
· Choosing Chart from the Insert menu.
· Clicking the Insert Chart button on the Standard toolbar.

· Choosing one of the slide layouts that include a Content placeholder, and then clicking the Insert Chart icon in the center of the placeholder.
Creating a chart using any of the above-mentioned methods opens Microsoft Graph, the program used by PowerPoint to create charts. When users create a new chart, a sample datasheet appears. A datasheet is a table in which the numbers and labels used to create a chart are keyed.
Choosing a Slide Layout for a Chart

When a new slide is created, the Slide Layout task pane offers several Content Layouts that are suitable for charts. Using Text and Content Layouts, users can easily combine a chart and the body text on the same slide.
Making Changes to Sample Datasheet

A datasheet contains rows and columns. Users key each number or label in a separate cell. A cell is the rectangle formed by the intersection of a row and a column. 
A datasheet also contains gray column headings and row headings with a button-like appearance that indicates row numbers and column letters. A datasheet can be moved by dragging its title bar and resized by dragging its borders. When working on a datasheet, the mouse pointer is a white cross called a cell pointer.

Deleting Sample Data

Clicking the cell from which contents are to be deleted, and pressing [Delete] deletes the sample data.
Keying New Chart Data

A Microsoft Graph datasheet contains an unnumbered row above row 1 and an unlettered column to the left of column A. This is where users key chart labels that appear below columns or in a legend to identify chart content.

Switching Rows and Columns

When users key data for a new chart, Microsoft Graph interprets each row of data as a data series. On a column chart, each data series is usually displayed in a distinct color. Users can choose to enter data in rows or columns, and can change the way the data is displayed on the chart. This can be done by clicking the By Column or the By Row button on the Standard toolbar.
Hiding the Datasheet and Viewing the Chart

Users can hide a datasheet by clicking its Close button or by clicking the View Datasheet button on the Standard toolbar when they are using Microsoft Graph.
To redisplay the datasheet, users must click the View Datasheet button again or choose Datasheet from the View menu.
	Lesson Key Objective

Explain how to create, format, and work with different types of charts.
Teaching Tip:

Inform students that the terms “chart” and “graph” are sometimes used interchangeably, although in this lesson, the term “chart” is used consistently.

[image: image1.emf]Choose a Slide  Layout for a Chart


Teaching Tip:

In older versions of PowerPoint, chart layouts were used to insert charts. Inform students that those layouts are still available at the bottom of the Slide Layout task pane.
Text Figure: F12-01

[image: image2.emf]Make Changes to  Sample Datasheet

 
[image: image3.emf]Make Changes to  Sample Datasheet


Additional Notes:

When working in Microsoft Graph, ensure that you click the mouse pointer only inside the datasheet, within the sample chart, or on the toolbar buttons and the scroll bars. Clicking anywhere else closes Microsoft Graph and returns the user to Normal view. Double-click the chart displayed on the slide to reopen Microsoft Graph.
Text Figure: F12-02

Teaching Tip:

Ensure students understand the consequences of clicking outside a chart. If they click off the chart (for example, in the gray area of the slide), the datasheet and Chart menu disappear and the program returns to Normal view.
Additional Notes:
Although you can perform multiple Undo actions elsewhere in PowerPoint and in other Microsoft Office programs, you get only one chance to undo an action when editing a chart. 
Teaching Tip:

Although many people consider bar charts to be horizontal or vertical, PowerPoint uses “column chart” for vertical bars and “bar chart” for horizontal bars to distinguish between the different orientations.
Text Figure: F12-03

Additional Notes:

Remind students that entering data in a cell is a two-part process. They must key the data, and then move to another cell. If the insertion point remains in the cell, the chart does not reflect the change. Students can press [Tab], an arrow key, or [Enter] to complete the process of entering data in a cell.
Additional Notes:

If you key labels in other rows or columns or leave gaps between columns or rows as you enter data, your chart will not display correctly.

[image: image4.emf]Switch Rows and  Columns

 
[image: image5.emf]Switch Rows and  Columns


Text Figure: F12-04

Additional Notes:

Number formatting is not an issue in a datasheet. However, if you want to align decimals and add commas, use the Formatting toolbar.
Text Figure: F12-05
Teaching Tip:

Explain to students that they can resize the datasheet window just as they would resize any window. They need to position the pointer on a corner or side edge of the datasheet window and drag the two-pointed arrow.

	Section 12.2

Formatting a Column Chart

Users can make formatting changes to a column chart, including:

· Changing the colors, patterns, fonts, and number formats of a chart.

· Altering the appearance of a chart’s axes by changing text color, size, font, and number formatting.

· Changing the scale and tick mark settings.

The scale indicates the values that are displayed on the value axis and the intervals between those values. Tick marks are small measurement marks, similar to those found on a ruler, that can show increments on the value axis (on the left for column charts) and the category axis (on the bottom for column charts).
These changes can be made using the Format Axis dialog box, which can be displayed in one of the following ways:

· Double-clicking an axis.

· Selecting an axis and clicking the Format button on the Standard toolbar or pressing [Ctrl]+[1].

· Right-clicking an axis and choosing Format Axis from the shortcut menu.

Exploring Parts of a Chart

PowerPoint provides several tools to help users to navigate around the chart. ScreenTips help users to identify parts of a chart and select the part of a chart on which they want to work.

Working with Solid Color Fills

Users can change the colors of individual chart areas, columns, or an entire group of columns. This can be done by selecting the object and using the Fill Color button on the Standard toolbar.

Working with Pattern and Gradient Fills

Special fill effects, including textures and gradient fills, can be applied in the same manner as they are used for other PowerPoint objects. Users can also change the border style of columns, bars, and other chart elements.

Formatting the Value Axis

A ScreenTip can be used to identify the value axis. The Format Axis dialog box enables users to format the value axis.
Formatting the Category Axis

Users can format the category axis in the same way as the value axis.
Inserting Axis Titles

Axis titles ensure that charts are interpreted correctly. Users can insert an axis title by:
· Moving the mouse pointer near the right edge of the chart until users see the Chart Area ScreenTip.

· Right-clicking the chart area and choosing Chart Options from the shortcut menu.

· Clicking the Titles tab on the Chart Options dialog box.

· Keying the title in the Category (X) axis and the Value (Z) axis text box.
Changing or Removing the Legend

A legend is a box showing the colors and patterns assigned to a data series. Users can customize a chart’s legend by changing the border, background colors, and font attributes. The Format Legend dialog box is used to change or remove a legend.

	Additional Notes:

Pressing [Ctrl]+[1] opens the formatting dialog box that is appropriate for the currently selected chart element.
Teaching Tip:

Since students are now beginning to make significant changes as they edit their charts, remind them that they can undo only the most recent change when they are in Microsoft Graph.

[image: image6.emf]Explore Parts of a  Chart


Teaching Tip:

As students move around the chart, remind them that they can open dialog boxes for various chart objects by double-clicking the object or by right-clicking and using the shortcut menu. In addition, they can use the menu bar.
Text Figures: F12-06, F12-07

[image: image7.emf]Format the Value  Axis


Additional Notes:

Pattern fills are a good choice when you print your slides in black and white or if you want to use the chart in a report that is printed in black only. However, this multicolor treatment might seem a little too colorful for a business presentation.
Text Figure: F12-08

Teaching Tip:

Explain to students that the category axis is sometimes referred to as the x-axis, and the value axis as the y-axis.
Teaching Tip:

If the Formatting and Standard toolbars are on one row, students will not have easy access to all the buttons they need. So, if necessary, ask students to drag the Formatting toolbar down, so it will dock below the Standard toolbar.
Teaching Tip:

Point out to students that the Auto Scale option, located in the lower-left corner of the Format Axis dialog box, can be used to size text automatically.
Text Figure: F12-09
Teaching Tip:

Point out that simple text formatting, such as making text bold or italic, can also be applied to a selected chart text object by using the Formatting toolbar or keyboard shortcuts. For example, with the legend or an axis selected, you can press [Ctrl]+[I] to make the text italic.

Text Figure: F12-10



	Section 12.3

Using Different Chart Types

PowerPoint offers a wide variety of chart types. The default chart type is 3-D Column Chart. Other chart types include:

· Bar
· Area
· Line
· Pie
· Surface
Users can include more than one chart type on a single chart.
Users can add a secondary axis in a two-dimensional (2-D) chart, so that they can plot data against two different scales. This feature enables users to work with two types of data on the same chart. A secondary axis is also a good choice if users need to display numbers that vary greatly in magnitude.
Switching to Other Chart Types

Users can change chart types in the following ways:

· Choosing Chart Type from the Chart menu.

· Right-clicking the chart area and choosing Chart Type from the submenu.

· Clicking the list box arrow for the Chart Type button, floating the Chart Type menu, and then making a selection from the Chart Type toolbar.

Adding a Secondary Chart Axis

A 3-D chart must be changed to a 2-D chart in order to be able to add a secondary chart axis.
Users can add a secondary chart axis by:
· Activating the chart.
· Right-clicking one of the columns and choosing Format Data Series from the shortcut menu. 
· Clicking the Axis tab.

· Selecting Secondary axis in the Plot series on option box.
Combining Chart Types

Users can distinguish between different data types on a single chart by assigning different chart types.
Formatting a Primary and Secondary Axes

Proper formatting and labeling of the axis is necessary for viewers to understand the information being conveyed.


	
[image: image8.emf]Switch to Other  Chart Types


Text Figure: F12-11

Teaching Tip:

Explain to students that the Axis tab is available only with certain 2-D charts. If they are working on a 3-D chart, the Axis tab will not appear on the Format Data Series dialog box.

Text Figures: F12-12, F12-13, F12-14

[image: image9.emf]Combine Chart  Types


Additional Notes:

It is best to avoid red and green in order to distinguish between data on column and bar charts. Some individuals have difficulty distinguishing between these two colors.



	Section 12.4
Working with Pie Charts

A pie chart is a simple and effective presentation tool that shows individual values in relation to the sum of all the values. In other words, it makes it easy to judge “parts of a whole.” Each value is displayed as a “slice” of the pie. A pie chart can show only one data series. To display more than one data series, more than one pie chart needs to be used.

Creating a Pie Chart

Users can create a pie chart by:

· Clicking the Insert Chart button on the Standard toolbar.

· Clicking the list box arrow for the Chart Type button on the Standard toolbar.

· Choosing Pie Chart.
Adding Pie Slice Labels
Users can add labels to the chart’s data series and edit those labels individually. Users can add labels to a pie chart by:

· Right-clicking one of the pie slices and choosing Format Data Series.
· Clicking the Data Labels tab. 
· Selecting both Category name and Percentage in the Label Contains section.
Formatting the Pie Plot Area

The plot area of a chart is the area containing the actual columns, bars, or pie slices. It can be formatted with or without a border and a fill effect. Right-clicking the plot area and selecting Format Plot Area from the shortcut menu enables users to format the plot area of the pie chart.
Enhancing a Pie Chart

Users can enhance the appearance of a pie chart with additional effects, such as changing the color of a slice or exploding a slice for emphasis. Selecting the pie and dragging any slice out from the center of the pie is called exploding a slice.

	Text Figure: F12-15
Additional Notes:

Depending on the pie chart, parts of the data labels may be hidden by the edges of the chart placeholder. In this case, you need to resize the pie by using the plot area sizing handles.
Text Figure: F12-16


[image: image10.emf]Add Pie Slice Labels

 
[image: image11.emf]Format the Pie Plot  Area


Teaching Tip:

If students attempt to reposition the pie by dragging it, instead of the expected result, pie slides will “explode.” If this happens, tell them to use the Undo command.

Additional Notes:

You cannot move the plot area to center it. However, if you resize the plot area from opposing corners, you can maintain its position within the chart area.


[image: image12.emf]Enhance a Pie Chart


Additional Notes:

Use Fill Effects to apply gradient fills, patterns, or textures to individual slices.

Teaching Tip:

Inform students that they can explode an entire pie, that is have all slices separated from each other, by selecting the pie and dragging any slice away from the center.
Additional Notes:

Although you can also insert text boxes in an active chart, you will sometimes want to do this in Normal view, so you can place the text outside the chart area.

Text Figure: F12-17



	Section 12.5
Importing Charts from Excel

Users can import charts created in Excel and other programs. An Excel chart can be inserted in a PowerPoint presentation in one of the following two forms:
· As an embedded object—An embedded Excel chart becomes part of the presentation in which it is placed, and is saved as part of the file.
· As a linked object—A linked Excel chart is a pointer to an external file that contains the data. 
Embedding an Excel Chart

Users can embed an Excel chart using the Insert Object dialog box which can be accessed by selecting Object from the Insert menu. The Insert Object dialog box enables users to create a new Excel chart or to insert a chart from a file.

Inserting a Linked Excel Chart

When users link an Excel chart on a PowerPoint slide, it is recommended to save the chart’s file in the same directory where their presentation is saved. Then, if they need to move or copy their presentation, they need to copy the Excel chart file along with it. Another alternative is to save the Excel file (before linking) on a shared network drive to which all potential viewers have access.

	Teaching Tip:
Ensure that students understand the difference between an embedded object and a linked object.
Text Figures: F12-18, F12-19, F12-20


[image: image13.emf]Insert a Linked Excel  Chart


Teaching Tip:
Linking and embedding objects is a complex topic. Linking files can cause problems if the linked file is not saved in the same directory as the presentation file before it is linked. 
Additional Notes:

Change the grayscale settings of a chart to Black with Grayscale Fill, so that the labels are seen.

	Section 12.6
Enhancing Chart Elements

Users can add many interesting effects to their charts. For example, users can:

· Add objects that help to highlight an aspect of the data.
· Annotate charts with text.

· Animate text and graphic objects. 
· Animate charts to make each data series, category, or pie slice appear one at a time, automatically, or on a mouse click.
Adding AutoShapes for Emphasis

The AutoShapes menu on the Drawing toolbar, available from within Microsoft Graph, can be used to add AutoShapes. To display the Drawing toolbar, right-click any open toolbar and choose Drawing from the shortcut menu, or click the Drawing button on Microsoft Graph’s Standard toolbar.

Animating Chart Elements

Some animation effects enable users to make chart elements appear one at a time. Effects that can be combined well with charts are:

· Dissolve In
· Split
· Random Bars
· Blinds
· Wipe
	Teaching Tip:

If the required buttons are not available on the Drawing toolbar, inform students that they need to click within the chart area to activate them.

Teaching Tip:

Students might need a reminder about how to work with AutoShapes and how to rotate an object.

[image: image14.emf]Add AutoShapes for  Emphasis


Additional Notes:

If you cannot see the arrow’s rotation handle, use Zoom to enlarge your view of the arrow.

Additional Notes:

You can also draw and add text boxes in Normal view.

Text Figure: F12-21

Additional Notes:

Some animation effects do not have options available in the Group chart list box. If no choices are available, try a different animation effect.
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